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Welcome

Avenza welcomes you to mapmaking in the 21st century!

Combined with Adobe Illustrator, MAPublisher has revolutionized the art of mapmaking by allowing spatial data 
files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to 
be performed where they should be done; in a powerful graphics environment.

MAPublisher LabelPro™ revolutionizes the way users can label map data, including using symbols as labels, conflict 
resolution, and highly configurable rule-based labelling options. The MAP LabelPro engine uses map data attributes 
for labelling with styles, rules and controls configured through an intuitive, easy-to-use Graphical User Interface.

This tutorial assumes that the user is familiar with Adobe Illustrator CS3 or CS4, and has at least a basic understanding 
of MAPublisher functions. This tutorial should be used in conjunction with the MAPublisher 8 User Guide , 
MAPublisher 8 Tutorial Guide and Quick Start Guide for an understanding of all the other MAPublisher tools. 

By following this tutorial, you will learn how to setup and use the MAP LabelPro labelling engine to label your 
map created in MAPublisher. Working on a provided map, users learn to create rules and styles for labelling in an 
automated and efficient way. 

Not all MAPublisher tools are explained in this document. Exercises related to each individual tool are covered in the 
full MAPublisher 8 Tutorial Guide.

MAP LabelPro Tutorial Data

This tutorial will use Adobe Illustrator files and MAP LabelPro rules supplied on your MAPublisher 8 CD or in the 
electronic download. Alternatively, if you have installed the software, you can find the MAP LabelPro Tutorial data in 
the following location on your hard drive:

Windows XP
C:\Documents and Settings\All Users\Shared Documents\Avenza\MAPublisher 8\MAP LabelPro Tutorial & Data\Data

Windows Vista
C:\Users\Public\Public Documents\Avenza\MAPublisher 8\MAP LabelPro Tutorial & Data\Data

Note:	 This data may be accessed through shortcuts available in the Windows start menu 

Mac OS X
/Applications/Avenza/MAPublisher 8/MAPublisher Tutorials/MAP LabelPro Tutorial & Data/Data

You are encouraged to experiment with your own data to gain additional experience with MAPublisher tools.
 
Tutorial data courtesy of City and County of San Francisco (San Francisco Enterprise GIS program SFGIS).
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0  Preliminaries

0.1  Purpose

The purpose of this exercise is to use MAP LabelPro to create labels for a simple map of downtown San Francisco, 
California, USA. For this exercise, Avenza has prepared the necessary map file created with MAPublisher 8 and Adobe 
Illustrator, based on City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS). The map 
contains all the different type of features (point, line and area) for labelling and/or obstacle purpose. 

In this exercise, you will start by preparing the file and examining the data to familiarize yourself with the 
prerequisites to using MAP LabelPro. Then, the labelling will be done in two steps: a main labelling session (labelling 
public schools, streets, interstates, highways and land areas in one run) and a secondary session (labelling parks 
only, using the other labels as obstacles). Although the presented settings are valid only for the map data they are 
based on, the principles are applicable for your own designs.

0.2  Know your data

The MAP LabelPro Tutorial data folder contains a ready-to-use Adobe Illustrator template file containing a map of 
downtown San Francisco (MAPLabelPro_Tutorial.ait). Here is a description of the layers present in the file and how 
they will be used during the labelling process.

0.2.1  San Francisco map description

Layer name Type Description Labelling Attribute
(label source layers)

Obstacle?
Session #1 | Session #2

Text layers

LAND_labels Text Land labels - - No

SCHOOL_labels Text School labels - - Yes

STREET_labels Text Street labels - - Yes

PARK_labels Text Park labels - - -

HIGHWAY_INTERSTATE_labels Text Labels for highways and interstates - - Yes

SUPPRESSED_labels Text Labels that couldn't be placed 
based on the specified rules.

- - No

MAP_TITLE Text Map title (San Francisco) - Yes No

MAP Layers

Public_Schools_point Point Public school locations SCHOOL_NAME Yes Yes

Post_Offices_point Point Post office locations - Yes Yes

Highways_line Line Highway roads HIGHWAY_NUMBER Yes Yes

Interstates_line Line Interstate roads INTERSTATE_NUMBER Yes Yes

Ramp_line Line Ramps to highways - No No

Streets_line Line San Francisco street network STREETNAME No No

Land_area Area Land areas AREA_NAME No No

Parks_area Area Park areas PARK_NAME Yes No
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Layer name Type Description Labelling Attribute
(label source layers)

Obstacle?
Session #1 | Session #2

Other Layers

Scale_Bar Legend Scale bar - -

background Area Blue background to represent 
the sea

- -

All map layers were imported from City and County of San Francisco GIS data (San Francisco Enterprise GIS program 
SFGIS) in ESRI shapefile format and cropped to the area of interest. The map design (symbols and line styles) was 
created by Avenza Systems.

0.2.2  Styles and rules
MAPublisher is installed with predefined styles and rules to use for the MAP LabelPro settings in this tutorial. These 
configuration files are saved to one of three folders depending on the data type layer,  Area,  Line or	  Point, 
they are associated with. 

Layer Name Type Style
\LabelPro\Styles

Rule
\LabelPro\Rules

Public_Schools_point Point School_Label_Style School_Label_Rule

Interstates_line Line Interstate_Label_Style Interstate_Label_Rule

Highways_line Line Highway_Label_Style Highway_Label_Rule

Streets_line Line Street_Label Style Street_Label Rule

Parks_area Area - -

Land_area Area Land_Label_Style Land_Label_Rule

The style and rules for the Parks_area layer will be created during the second labelling session of this exercise. 

The default location of the Rules and Styles folders is:

Windows XP: C:\Documents and Settings\All Users\Application Data\Avenza\MAPublisher 8\LabelPro\Rules
Windows Vista: C:\ProgramData\Avenza\MAPublisher 8\LabelPro\Rules
Mac OS X: Applications/Avenza/MAPublisher 8/MAPublisher Plug-In/LabelPro/Rules

Note:	 The MAP LabelPro tutorial data folder also contains a backup for these rules and styles

0.2.3  Important note for MAPublisher LabelPro evaluation users
The evaluation version of MAPublisher LabelPro scrambles the text of placed labels but preserves the case, spacing 
and punctuation, so that the results give a sense of how actual labels would be placed. Therefore, evaluation users 
will experience a different result with the MAP LabelPro settings of this tutorial than the licensed users. Throughout 
this document, both results will be shown and differences explained. In evaluation mode, the scrambling process 
noticeably slows the speed of labelling.
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1  Getting Started

1.1  Open tutorial document

1.	 In the Adobe Illustrator main menu, choose File> Open and open the template file MAPLabelPro_Tutorial.ait located 
in \MAPublisher 8\MAP LabelPro Tutorial Guide & Data\Data. 

An artboard containing a map of San Francisco opens. All the data information to be used for labelling is present, 
except for the text labels. Please see the table in the Preliminaries chapter for the description of the layers.

2.	 Because the file was opened from a template, a new untitled document was created. Choose from the Adobe 
Illustrator main menu File > Save As to save the file as San Francisco.ai.

Note:	 Customize the Adobe Illustrator workspace to make it easier to access panels. It may look different than 
the image above. Read Customizing the workspace in the Adobe Illustrator help guide for more information. 
Review also MAPublisher Preferences in the MAPublisher 8 User Guide.

1.2  Examine MAP Attributes available for labelling

MAP LabelPro extracts label data from the attribute table for each MAP Layer to be labelled. Therefore, it is good 
practice and often required to examine or edit attribute information using the MAP Attributes panel. Edits can 
include: creating a new column to enter attribute values, joining tables to import additional attribute information 
from an external file, correcting spelling, changing the case of text and more.

For this exercise, all attributes are ready to use for labelling. Follow the steps here to examine them and familiarize 
yourself with the data.

Note:	 For more information on the MAP Attributes panel, please refer to the MAPublisher 8 User Guide, chapter 5. 
For more exercises, please see the MAPublisher Quick Start Guide and MAPublisher Tutorial Guide.
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1.	 In the Adobe Illustrator Layers panel, click the target button  next to the Public_Schools_point layer to select 
all artwork on the layer.

2.	 Open the MAP Attributes panel (from the Adobe Illustrator main menu, choose Window > MAPublisher> MAP 
Attributes or click the MAP Attributes button on the MAPublisher toolbar. ).

The Public_Schools_point layer contains four visible attribute columns: OBJECTID, FACILITY_I, DEPTNAME and 
SCHOOL_NAME. The SCHOOL_NAME attribute column will be used for labelling the school points.

3.	 Select all artwork on the Interstates_Line layer and view the attributes in the MAP Attributes panel.

The INTERSTATE_NUMBER attribute column will be used for labelling these roads.

Note:	 Notice that the INTERSTATE_NUMBER attribute is of type integer . All types of attributes may be used for 
labelling with MAP LabelPro.

4.	 Select all on the Highways_line layer and view the attributes in the MAP Attributes panel. HIGHWAY_NUMBER 
will be used for labelling. View the attributes of the remaining layers: Streets_line, Parks_area, and Land_area.

Refer to the San Francisco description table in section 0.2.1 to see the attributes that will be used for labelling.

5.	 Close the MAP Attributes panel when finished reviewing.

Knowing this information, we are ready to use the MAP LabelPro function to generate map labels for the San 
Francisco downtown map.



9MAPublisher 8 MAP LabelPro Tutorial
2  Labelling Session #1

2  Labelling Session #1

In this first labelling session, multiple layers will be labelled in a single run of the MAP LabelPro function. The 
objectives for this session are to:

•	 Add labels for school as a first priority (source layer Public_Schools_point).
•	 Label the interstate roads with interstate shield symbols containing the interstate number (source layer 

Interstates_line).
•	 Label the highway roads with highway shield symbols containing the highway number (source layer 

Highways_line).
•	 Add street names (source layer Streets_line).
•	 Add names for land areas, written in the sea to make the map more readable (source layer Land_area).
•	 Make sure that the school and road names do not overlap with the post office and school symbols and park 

area, and do not cross highways and interstates line (obstacle layers: Post_Offices_point, Public_Schools_
point, Parks_area, Interstates_line and Highways_line).

To start the MAP LabelPro Editor, click the MAP LabelPro button  on the MAPublisher Toolbar.

The MAP LabelPro dialog box opens.

All layers have to be configured before labelling with MAP LabelPro. The general MAP LabelPro workflow: setup 
source layers, specify attribute to be labelled, set label destination or suppression layers, set label priority and define 
layer styles and rules. 

If the dialog box needs to be closed before all configurations are done, make sure to click the Save button. If 
labelling has been executed and an Undo action is used afterwards, the configurations in MAP LabelPro will revert 
to the configuration before the labelling was executed. To ensure that your configuration is saved, click the Save 
button before labelling.

MAP LabelPro
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2.1  Layers and obstacles setup

1.	 In the MAP LabelPro editor dialog box, click the Setup Layers button.
2.	 In the Setup Layers dialog box, click the Label check box for each of the following layers to enable them as 

source layers:
•	 Public_Schools_point
•	 Highways_line
•	 Interstates_line
•	 Streets_line
•	 Land_area

3.	 Click the Obstacle check box for each of the following layers to enable them as obstacle layers:
•	 MAP_TITLE
•	 Post_Offices_point
•	 Public_Schools_point
•	 Highways_line
•	 Interstates_line
•	 Parks_area

4.	 Make sure that the settings match the image above and click OK.

The MAP LabelPro dialog box gets updated according to the layers settings. Selected layers for labelling are 
added to the Source list and selected layers for obstacles are added in the Obstacle layers list. 
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2.2  Labelling extents setup

The configuration described in this exercise will limit the creation of labels to the extent of the selected source 
layers for labelling, with a margin of 0.2 inches on each side.

1.	 Click the Advanced button in the MAP LabelPro dialog box.
2.	 Under Label Placement Area, choose the option Extents of labeled source layers.
3.	 Click the Label Margins check box. Set the Top, Left, Right and Bottom drop-down lists to 0.2 in.

Note:	 If the option Paths without stroke are not considered obstacles is enabled, areas that have no stroke will not be 
used as an obstacle in the labelling process, allowing generated labels to overlap with them.

4.	 Make sure that the settings match the image above and click OK.

The label styles and rules of each source layer are now ready to be set.
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2.3  Point layer label settings

1.	 In the MAP LabelPro editor dialog box, click Public_Schools_point in the Source column to highlight the row.

By default, the attribute to use as a label is set to FACILITY_I, the first string attribute column of the 
Public_Schools_point layer. It needs to be changed to SCHOOL_NAME.

2.	 Click FACILITY_I in the Attribute column. This enables a drop-down list with all the attributes of the 
Public_Schools_point layer. Choose SCHOOL_NAME from the drop-down list.

3.	 In the Destination column, choose SCHOOL_labels from the drop-down list.

Note:	 Increase the width of an attribute column to see its full name.

Leave the Priority column set to 1. The Public_Schools_point layer will be labelled as a first priority while the 
others will be set to a secondary priority.

4.	 In the Style column, click [Default] and choose School_Label_Style from the drop-down list. Click the Edit button 
 to open the Style dialog box and examine its settings. This style was predefined.

Note:	 The second labelling session will show how to create a new style from scratch.

5.	 After reviewing the Style settings, click OK to close it.
6.	 In the MAP LabelPro dialog box, under the Rules column, click [Default] and choose School_Label_Rule from the 

drop-down list. Click the Edit button  to open the Point Rules dialog box and examine its settings. This style 
was predefined.
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These point settings will force the labels to be placed below the symbols:
•	When possible, the text will be placed lower-middle to the symbol. 
•	If this is not possible due to space constrictions, text will be placed to the lower-right, and then to the lower-left.
•	If none of the options can be applied, the text will be placed on the suppression layer (or ignored if no 

suppression layer was specified).
•	Text stacking and font reduction have also been enabled to add flexibility to the placement rules.

Note:	 More information on the available labelling options can be found in the MAPublisher User Guide, chapter 18.

7.	 After reviewing the Point Rules dialog box, click OK to close it.
8.	 In the Suppression Layer column, click the text [Ignored] and choose SUPPRESSED_labels from the drop-down list. 

Labels that can not be placed will be copied to the SUPPRESSED_labels layer.

Note:	 Scroll to the right of the MAP LabelPro dialog box or expand it to see the Suppression Layer column.

This finalizes the configuration for the labelling of the Public_Schools_point layer. Do not close the MAP LabelPro 
dialog box as the configuration of the roads and land layers still have to be set. If you want to save the current 
configurations, click the Save button. You will have to reopen the MAP LabelPro dialog box to continue.
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2.4  Line layers label settings

This section covers the labelling configuration for the source layers Highways_line, Interstates_line and Streets_line. 
Highways and interstates will be labelled using highway and interstate symbol shields—notice that these layers 
contain double-lines for each road (divided highways). 

2.4.1  Label lines with symbols
1.	 In the MAP LabelPro dialog box, click the Highways_line layer name in the Source column to highlight the row.
2.	 In the Attribute column, choose HIGHWAY_NUMBER from the drop-down list.
3.	 In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).
4.	 Set the Priority column to 2. 
5.	 In the Style column, choose Highway_Label_Style from the drop-down list. Click the Edit button  to open the 

Style dialog box and examine its settings. This style was predefined. 

In addition to the regular font settings, line labels can also be labelled with symbols. In this case, the Label with 
symbol option is enabled. Symbol files (*.lsf ) contain a series of symbols. In the example above, the United States 
Interstate symbol is selected from the generic_shields.lsf symbol file. The symbol size is set to a height of 0.25 
inches. The symbol font color is set to white so it can be legible against the blue symbol.

6.	 After reviewing the Style settings, click OK to close it.
7.	 In the MAP LabelPro dialog box, in the Rules column, choose Highway_Label_Rule from the drop-down list. Click 

the Edit button  to open the Line Rules dialog box and examine its settings. These rules were predefined.
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With these settings, the highway labels (and shields) will be placed in the middle of each line length and on the 
centerline, with a font reduction (if necessary). The Divided Highways setting recognizes lines that are parallel 
and share the same name (as specified by the selected attribute). In such cases, it places only one symbol 
instead of two or more. The Allow labels to cross lines option needs to be enabled because double highway 
lines are very close in proximity and the labels need to cross the lines. More information on line labelling rules 
can be found in the MAPublisher 8 User Guide, chapter 18.

Note:	 Evaluation users will see a different result than a licensed user. Because of the text scrambling, the divided 
highways cannot be recognized. Here is an example with the interstates:

Result with license:		  Result with evaluation:

		   

8.	 After reviewing the Line Rules settings, click OK to close it.
9.	 In the MAP LabelPro dialog box, in the Suppression Layer column for Highways_line, choose SUPPRESSED_labels 

from the drop-down list. 

The settings for the Highways_line layer are completed. Continue with the settings for the Interstates_line layer.

10.	 Click the Interstates_line layer name in the Source column to highlight the row.
11.	 In the Attribute column, choose INTERSTATE_NUMBER from the drop-down list.
12.	 In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).
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13.	 Set the Priority column to 2.
14.	 In the Style column, choose Interstate_Label_Style from the drop-down list. Click the Edit button  to open the 

Style dialog box and examine its settings. This style was predefined.

The United States Route symbol is selected from the generic_shields.lsf symbol file. The symbol size is set to a 
height of 0.25 inches.

15.	 After reviewing the Style settings, click OK to close it.
16.	 In the MAP LabelPro dialog box, in the Rules column, choose Interstate_Label_Rule from the drop-down list. Click 

the Edit button  to open the Line Rules dialog box and examine its settings. These styles were predefined.

The labelling rules for the interstates are the same as for the highways. The previous note applies for evaluation 
users.

17.	 After reviewing the Line Rules settings, click OK to close it.
18.	 In the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list.

The label settings for the interstate roads are now complete. Continue with the street labels.

2.4.2  Label lines with text only
1.	 Inthe MAP LabelPro dialog box, click the Streets_line layer name in the Source column to highlight the row. Keep 

STREETNAME as the selected attribute for labelling.
2.	 In the Destination column, choose STREET_labels from the drop-down list.
3.	 Set the Priority column to 2. 
4.	 In the Style column, choose Street_Label_Style from the drop-down list. Click the Edit button  to open the 

Style dialog box and examine its settings. This style was predefined.
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Notice that this time Label with symbol is not checked.

5.	 After reviewing the Style settings, click OK to close it.
6.	 In the MAP LabelPro dialog box, in the Rules column, choose Street_Label_Rule from the drop-down list. Click the 

Edit button  to open the Line Rules dialog box and examine its settings. These rules were predefined.

Like highway and interstate labels, street labels will be placed in the middle of each line length and on the 
centerline, with an eventual font reduction if necessary. The ability to overhang is enabled here.

The street lines in this file are not joined. For example, each street is made of many line segments that all share 
the same STREETNAME attribute. To avoid repeating the name of connecting lines, the Label joined feature rule 
is enabled. MAP LabelPro recognizes that connecting lines sharing a same name need to be labelled only once.

Note:	 Evaluation users will see a different result than a licensed user due to the text scrambling. Names are not 
recognized as being the same and labels will be created for each line segment rather than one per street.
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	 Result with license:			   Result with evaluation:

	 		   

7.	 After reviewing the Line Rules settings, click OK to close it.
8.	 In the MAP LabelPro dialog box, in the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list. 

This completes the label settings for all line layers. Do not close the MAP LabelPro dialog box as the configuration 
of the Land_area layer still has to be done. If you want to save the current configurations, click the Save button. You 
will have to reopen the MAP LabelPro dialog box to continue.

2.5  Area layer label settings

This section covers the labelling configuration for the source layers Land_area. The goal is to add large labels for the 
land areas of the map (downtown area, Treasure and Alcatraz Islands). 

1.	 In the MAP LabelPro dialog box, click the Land_area layer name in the Source column to highlight the row. Keep 
AREA_NAME as the selected attribute for labelling.

2.	 In the Destination column, choose LAND_labels from the drop-down list.
3.	 Set the Priority column to 2. 
4.	 In the Style column, choose Land_Label_Style from the drop-down list. Click the Edit button  to open the 

Style dialog box and examine its settings. This style was predefined. 

Note:	 The sample text in the preview is cut off because the font size is set to 70 pt.

5.	 After reviewing the Style settings, click OK to close it.
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6.	 In the MAP LabelPro dialog box, under the Rules column, choose Land_Label_Rule from the drop-down list. Click 
the Edit button  to open the Area Rules dialog box and examine its settings. These rules were predefined. 

The main requirement for labels created from the Land_area layer is that labels are placed in the water area. 
Therefore, the Allow outside rule is the only placement option enabled. Stacking and font reduction option are 
also enabled to give more flexibility to the rule. More information on the available area labelling rules can be 
found in the MAPublisher 8 User Guide, chapter 18.

Note:	 Labelling Session #2 will explain the creation of area rules for the Parks_area layer.

7.	 After reviewing the Area Rules settings, click OK to close it.
8.	 In the MAP LabelPro dialog box, in the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list. 

All layers have been now configured for the first labelling session.
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2.6  Execute labelling with MAP LabelPro

1.	 Make sure that all the layers have been configured to match the image below and click the Save & Label button.

Note:	 For this session, the other labelling options will be kept as default:

•	 Source Art: option to label all the source layers or label only the selected art on each source layer. In the 
example above, all objects will be labelled exactly as found in the source attributes.

•	 Options: statistics type option displays a report on placed and non-placed objects. It will be used in the 
Labelling Session #2. For this example, the option is set to None.

Note:	 For evaluation users only. Review the MAPublisher warning message and click OK to close it.

2.	 Wait for the process to end to visualize the results (see next page).

The map layers are labelled. Make the SUPPRESSED_labels layer visible to show labels that couldn't be placed 
with the specified rules.

3.	 Save the file and leave it open to continue on with the second labelling session.
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Result with  full license:

 	

Result with evaluation license:

		

Note:	 Evaluation users will observe scrambled labels on the map. The Label joined feature rule does not recognize 
similar street names due to the text scrambling and places more labels than necessary. Similarly, highway 
and interstate roads are labelled with two shields with different numbers. Licensed versions will not see any 
text scrambling.
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3  Labelling Session #2

In this second labelling session, continue with the San Francisco.ai file that you saved. This time, only the parks will 
be labelled in a single labelling execution of MAP LabelPro. The objectives are to:

•	 Create a new area label style for park labels.
•	 Create a new area label rule for park labels.
•	 Make sure that the park labels do not overlap with the other labels and with the post office and school 

symbols, and do not cross highway and interstate lines.

To start MAP LabelPro, click the MAP LabelPro button  on the MAPublisher Toolbar. The settings from the 
previous labelling session are remembered. For the new session, the layer setup has to be changed to match the 
new objective of this exercise. However, the label extents remain the same as before.

3.1  Layers and obstacles setup

1.	 In the MAP LabelPro Editor, click the Setup Layers button to setup the source and obstacle layers.
2.	 In the Setup Layers dialog box, click the very top Label check box (at the level of the San Francisco Downtown 

MAP View). Click the check box again to uncheck all of the Label check boxes.
3.	 Click the Label check box of the Parks_area layer only.
4.	 Make sure that only the following layers are set as obstacles:

•	 HIGHWAY_INTERSTATE_labels
•	 SCHOOL_labels
•	 STREET_labels
•	 Post_Office_point
•	 Public_School_point
•	 Highways_line
•	 Interstates_line

5.	 Make sure that the settings match the image above and click OK. 

The MAP LabelPro dialog box is updated with the new selected layer setup.
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3.2  Additional area layer label settings

This section covers the labelling configuration for the source layer Parks_area. The goal is to add labels for the parks on 
the map, allowing the use of leader lines and font reduction. In this exercise, style and rules are created from scratch.

1.	 In the MAP LabelPro dialog box, click the Parks_area layer name in the Source column to highlight the row.
2.	 In the Attribute column and choose PARK_NAME from the drop-down list.
3.	 In the Destination column, choose PARK_labels from the drop-down list.

4.	 In the Style column, click [Default] and then click the Edit button  to open the Style dialog box. 
5.	 Make sure that Arial is selected in the Family drop-down list.
6.	 Make sure that Regular is selected in the Style drop-down list.
7.	 In the Size drop-down list, set the font size to 7.00 pt
8.	 Click the Browse button  beside the color chip.
9.	 In the Color Picker dialog box, pick a dark green color (e.g. R=0, G=85, B=0) and click OK.
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10.	 Make sure that the Style dialog box is setup as below and click Save As. 

11.	 In the Save As dialog box, type Park_Label_Style in the Name box and click Save.

12.	 In the Style dialog box, click OK to close it.

In the MAP LabelPro dialog box, the Style column now displays the text Park_Label_Style. The style is saved in 
the directory specified in the MAPublisher Preferences (see exercise 1.2).

13.	 In the MAP LabelPro dialog box, under the Rules column, click [Default] and then click the Edit button  to 
open the Area Rules dialog box.

14.	 In the Area Rules dialog box, under Placement, click the check box for the Allow extending beyond boundary.
15.	 Check the checkbox for Allow use of leader line. Keep the default parameters.
16.	 For the Allow stacking rule, choose Up to 4 lines from the drop-down list.
17.	 Uncheck the check box for Allow labels to cross lines.
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18.	 Click the Save As button and in the Save As dialog box, type Park_Label_Rule in the Name box and click Save.

19.	 In the Area Rules dialog box, click OK to close it.
20.	 In the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list. 

In the MAP LabelPro dialog box, the Rules column now displays the text Park_Label_Rule. The rule is saved in the 
directory specified in the MAPublisher Preferences (see exercise 1.2).

3.3  Execute labelling with MAP LabelPro

1.	 In the MAP LabelPro dialog box, in the Options frame, set the Statistics drop-down list to Show all.
2.	 Make sure that all the layers have been configured as below and click the Save & Label button.

A dialog box displays the statistics of the label placement (results might vary for evaluation users).
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3.	 After reviewing the statistics, click Close to close the LabelPro Messages dialog box.

Result with full license:

Result with evaluation license:

Congratulations, you have completed the MAPublisher 8 MAP LabelPro tutorial. For more in-depth information 
on MAPublisher tools and features, please take a look at the MAPublisher 8 User Guide , MAPublisher 8 Tutorial 
Guide and Quick Start Guide. These documents are installed with MAPublisher 8 or can be downloaded from 
http://www.avenza.com/documentation.
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